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Table of Contents This Quick Start Guide to the TRIUMPH-LS contains the 
basic information a user new to J-Field, the field software of 
TRIUMPH-LS and VICTOR-LS, needs to know to get started 
working quickly.  More information and details are provided 
in the User’s Guide to the TRIUMPH-LS.  J-Field also 
contains its own ever-growing on-board manual with 
context sensitive help files for various screens.  Press the 

hardware  (Help) button to learn more about each 
screen. 

J-Field is rapidly being developed with new updates typically 
being released monthly; because of this,  screenshots 
and features in this guide may appear differently from 
the latest version of J-Field.  Be sure to check www.javad.
com/jgnss/ and the user forum at http://support.javad.com 
frequently to stay current on all of the breaking news and 
innovative developments from JAVAD GNSS.  Details about 
new features can also be found in the Application Notes 
accessed from the Support menu.

Central to J-Field are four key concepts, briefly introduced 
here and that are discussed more fully in their respective 
sections:

Project - A user-defined job identifier with its own database file and folders 
for storing data

Page - Each Project has 10 pages that can contain points and lines and can be 
toggled on or off similar to CAD layers.  Each Page has the option of having its 
own coordinate system. 

ShapeTags - User-defined tags for points that can be assigned to create lines 
between points with like ShapeTags 

Codes - Each point has a Code field to store commonly used point descriptions.  
Once a Code has been created, it can be recalled from the Codes Library or from 
the Favorite Codes list. 

http://www.javad.com
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External GNSS 
antenna port

External UHF 
antenna port
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(when off and charging)

RS232 port

LAN port

Slant height 
measurement 
point

Charging port
Setup - Cycle between 
the Setup and Advanced 
Setup screens

Speaker

Collect - Cycle 
through the collect 
screens

Action - Open the Stake Action screen 
/ Expand White Box buttons
Zoom Out / Advance to the 
previous page/screen

Navigation 
buttons

Start - Start the collection 
of a point

Stop - Stop the 
collection of a 
point

Warnings - Press when 
the warning LED is red to 
view warning messages Help - learn more 

about the current 
screen

Stake - Cycle through 
the stake screens

Lock - lock the 
screen to pre-
vent accidental 
actions

Interference - Spectrum 
analyzer to check for 
interference in the 
GNSS bands

Screen - Cycle the screen to  
white or black backgrounds for 
better visibility in the sun

Print Screen - Capture 
a screenshot

A/V - Control 
sounds, 
volume 
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Battery - status 
of the battery 
and internal 
temperatures

Zoom In / Advance 
to the next page/
screen

Battery status 
LED

Charge Status 
LED

Check - Used to open or 
select the current item/box

Home - Press to return to 
the Home screen

On/Off - Turn on 
the unit, hold down 
if the system is 
unresponsive

Mute - Mute 
the sound

Speaker 

Light - Turn on/off the 
flashlightBuilt in 

Microphone

User Defined Buttons- 
Customizable to invoke desired actions 
/ functions

Light 
sensor

Proximity 
sensor

Anatomy - Exterior of TRIUMPH-LS 
Top, Left and Front Faces

High resolution 
capacitance 
color touch 
screen 

Slant height 
measurement 
point

USB Port - Use this port for connect-
ing USB storage drives and dongles 
to the TRIUMPH-LS.  This is not for 
connecting the TRIUMPH-LS to the 
computer.

Micro USB Port - This is for 
connecting the Triumph-ls 
to a computer.  Use the 
provided cable.  

Bottom 
Camera

Headset

Micro SD card slot

SIM CARD Slot 2

WiFi / Bluetooth 
Antenna

Serial number of 
the TRIUMPH-LS 

Flashlight1/4” 
x 20 
threads

Anatomy - Exterior of TRIUMPH-LS
Bottom, Right and Back Faces

Front 
Camera

SIM CARD Slot 1

Factory port 
covers

Optional shoulder 
strap connection 
plug

Internal Radio 
Antenna

Internal GSM 
Antenna
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UHF antenna 400-470 MHz, 
2.5dB, RT Angle, SMA (optional, 
if UHF module is installed)

AC Power Cable 

Ext Power/Charger 

Power Cable

AC Power Adapter

Charging kit 
Shown assembled while the TRIUMPH-LS is being 

TRIUMPH-LS

WiFiLAN

Inactive connections are gray 
and active connections are blue

Collect - Survey points 

Screen Anatomy - Home Screen 1

UHF GSM BT

Satellites, number of tracked 
satellites are shown above the icon 
and the Receiver Name is shown 
below

Volume

Stake - Stake points 
and lines

CoGo - Various CoGo 
Functions, DPOS and 
Camera Tools

Setup Summary, the 
setup profile name is 
displayed below

Setup - Configure the 
setup profiles

Coordinate Systems - lists all the system 
coordinate systems, not used to set the 
current coordinate system

Localize - Create localized coordinate 
systems

Files - Browse the file system, import 
and export files

Points -List the project points and 
polylines

Support - menu, used 
to request support 
and install updates.

ShapeTags & Codes - Manage 
ShapeTags, Codes and Symbols

Battery - The estimated 
hours : minutes of 
remaining battery life is 
shown below

GNSS Interference, the numeric 
value is the maximum magnitude 
of interference among all the GNSS 
bands

Click any icon in the top row to 
open its status screen

Extension cord 

not included

http://www.javad.com
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Screen Anatomy - Home Screen 2

Interference - Com-
plete GNSS spectrum 
analyze 

Camera - Capture pho-
tos with the front and 
bottom cameras

Data Exchange - 
Export / Import 
various data formats

System - Receiver 
details and 
information, etc. 

Language - Specify the 
language

Calibrate - Calibration 
for the level and 
compass

Base/Rover Setup - Start a 
RTK base station with a UHF 
or SS radio

Voice Recorder - 
Record audio notes

Locks - Prevent inadvertent 
screen interactions

Timing - Configure clock 
display format, set alarms, 
schedule data collection 

Calendar - Manage 
survey projects by 
date

Calculator - Several 
different calculators 
are available

Next Screen - 
Advance to the Home 
Screen 1

Previous Screen - 
Advance to the Home 
Screen 1

Tap to open the 
Timing screen

 

that the four LEDs have different 
meanings when the LS is on from 
their meanings when the unit is 
being charged.  When the unit is 
on, you’ll want to pay attention to 
the upper left LED as it alerts you of 
an immediate issue.

Anytime the TRIUMPH-LS displays 
this LED as red, press the warnings 
key to learn more and take any 
necessary corrective measures.

Help & Support

J-Field contains its own ever-growing on-board manual 
with context sensitive help files for various screens.  Press 
the hardware Help button to learn more about each screen.  
Contact information of the Live Technical Support team 
members are listed in Support>Live Technical Support.  You 
are also encouraged to submit your feedback and questions 
to the user’s forum located at http://support.javad.com.

Turning on The TRIUMPH-LS 

Powering the TRIUMPH-LS on is pretty straightforward 
with the underlying operating system; Windows Embedded  

Compact 7.0, loading first and then J-Field 
subsequently booting up. 

There are occasions when the system 
might freeze.  Should you experience this, 
simply depress the power key and hold 
down until the unit powers off, about 10 

seconds.  Any data collected up to that point will be saved.

Charging the Batteries

The TRIUMPH-LS AND VICTOR-LS come from the factory 
with the batteries charged and ready to use so you can 
begin exploring its interface and familiarizing yourself right 
away while reading this manual. 

Some of the cables and their 
connectors used in charging 
the equipment may not be 
familiar to you.  ODU style 
connectors are superior for a 
broad range of industrial 
power, communications 
and data applications 
that demand a precision-
engineered, secure and 
robust solution. 

When charging your receiver, be sure to line up the red 
dots on the connector and the charing port on the LS.  Note 

Lithium Ion batteries should not 
and cannot be charged when 

their temperature is above 40° C (104° F).  
They charge faster when they are cool. 
Therefore, it’s best that you turn off the 
unit when charging. Charging the unit 
when it’s on will cause it to charge more 
slowly (up to 40° C) due to its increased 
temperature. 

http://www.javad.com
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Calibration

The TRIUMPH-LS is an 
advanced scientific surveying 
instrument.  It is highly 
sensitive to its environment 
and includes a built-in 

magnetometer and 3-axis accelerometer. 

For the visual stakeout features and the Ahead/Back 
and Right/Left White Boxes in the Stake Action screen to 
work correctly, the electronic compass readings need to 
be accurate.  It is recommended to check the compass 
calibration before beginning work at a new location.  To 
check the calibration, rotate the TRIUMPH-LS 360° and 
observe the compass readings in the Collect or Stake 
Action screen.  There should be no twitching, quick jumps, 
or reversals of the displayed bearing or azimuth, just as a 
real compass would perform.  If this is not the case, the 
compass needs to be recalibrated or it may not be in a 
suitable environment for its use.  Follow the instructions on 
the screen to calibrate the compass.  When calibrating the 
compass, choose an area removed from overhead power 
lines, parked automobiles and other ferrous materials which 
cause magnetic disturbance.  The electronic compass works 
in areas that are electromagnetically uniform.

The Level calibration typically only needs to be preformed 
once.  Follow the instructions on the screen to calibrate the 
level.

The level sensors are sensitive to the internal temperatures 
of the TRIUMPH-LS.  To fine tune the level calibration, a 
Level Offset calibration needs to be done.  It is located in 
the Action Setup menu.  It is necessary to reperform this 
calibration as the internal temperature of the TRIUMPH-LS 
changes.  If the Correct For Tilts option is enabled and the 

most accurate positions are desired, it is essential to monitor 
the Level Offset calibration and recalibrate when necessary.

The Camera needs to be calibrated if you intend to use the 
camera’s Visual Angle or Camera Offset Survey tools.  This 
only needs to be done once.

Updates

Keeping your TRIUMPH-LS 
up to date is nearly effortless; 
however, you do need to 
ensure that you have Internet 

access in order to download the firmware and software 
updates.

The TRIUMPH-LS will automatically detect nearby WiFi 
networks.  To see the detected networks, as well as their 
respective signal strength, tap on the WiFi icon in the top 
row of icons on the Home screen and then at the bottom of 
that screen tap on Network.  Select the desired access point, 
tap on Connect, enter the case sensitive password, if any, 

and the connection should be established.  Once 
connected to a WiFi network it will be remembered 
and added to the Favorites and the connection to it 

will become automatic when it is detected.

If you do not have WiFi or for some reason are unable to 
connect to it, but do have a wired local area network, you 
can connect the TRIUMPH-LS to your network using a cable 
connected to the LAN port and your network interface 
card or router.  A wireless network can also be used if you 
have an installed SIM card data plan with sufficient data.

Points

Tap on this icon to review 
points, alignments, trajectories 
in J-Field.

Points Screen Displaying Design Points

Each point can have up to five types of coordinates that are 
displayed in the Points screen:

•	 Design Coordinates - Imported and manually entered 
coordinates are populated into this field and stored in  
the Project’s database file with their native coordinate 
system as was selected when they were imported.

•	 Survey Coordinates - These are coordinates determined 
from GNSS observation.  All surveyed points are stored 
with Survey Coordinates with WGS84 (ITRF 2008) 
coordinates.

•	 Base Station Coordinates - When a point is surveyed 
with RTK corrections, the base station coordinate is 
saved.

•	 Survey Shifted Coordinates - When a point’s base 

station coordinates have been adjusted or shifted, the 
shifted survey coordinates are displayed along with 
the unadjusted survey coordinates (Survey Origin).

•	 Base Station Shifted Coordinates - When a point’s base 
station coordinates have been adjusted or shifted, the 
shifted base station coordinates are displayed along 
with the unadjusted base station coordinates (Base 
Station Origin).

Edit Point Screen Displaying a Point with Each Type of 
Coordinate

Point Filters

Points are displayed in the coordinate system of the Current 
Page in the CoGo functions and in the map.  All new 
Survey Points and points created with the CoGo functions 
are created in the Current Page.  The Current Page can be 

selected by tapping  (Filter Button) to open the Filter 
screen.  The First row displays buttons for each of the 10 
pages.  The Current Page is highlighted green while visible 
pages are shown with bold numbers and hidden pages 
are shown with small gray numbers.  Tap a page button to 

http://www.javad.com
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toggle it between visible and hidden.  Objects in hidden 
pages are not display in the list of objects or on the map.

Filter Screen - Current Page is 1, Page 0 is hidden

The Pages screen can be open by tapping Pages.  It displays 
the page names and allows it to be edited along with the 
coordinate system and color.

 
Pages Screen - Current Page is 1, Page 0 is hidden

The Current Page is set with the toggle on the left while the 

visibility of Pages are controlled with the check box options 
on the right.

The In All Projects toggle will display points from all projects.  
This is usually not recommended as it will slow J-Field down 
if many points exist.

Points can be sorted in the displayed points list  by Distance, 
Alphabetical or Chronological.  Notice the down arrow in 
the corner of the Distance Filter button.  Holding this button 
down will initiate a Long Click and present additional 
options for the Distance Filter.

Origin of Distance Filter Options

Hide Staked hides points that have already been staked.  A 
point is considered staked after it has been staked with a 
surveyed coordinate accepted for it.

Hide Vertices hides points created from imported lines from 
being displayed in the point’s list.  J-Field defines lines as 
connections between points so every line must have points 
at its vertices.  For this setting to be applied the Hide Line 
Vertices option must be checked in the Common Settings 
screen when AutoCAD, DGN or Shapefiles are imported.

The  (Add) button allows new points to be added; with  
the Survey button selected you will be taken to the Stake 
Action screen; with the Design button select you can add a 
point with one of the four options shown.

Add Point Screen for Design Points

The  (Edit) button opens the Edit Points screen (shown 
on the previous page) to allow the various parameters of 
the point to be modified.

The  (Delete) button deletes the selected object.  A 
Long Click (tap and hold) on this button deletes all objects 
currently shown in the list, i.e. taking into account the 
general filter and name filter. 

The  (Type Filter) opens the Type Filters screen.  It allows 
points to be filter by Solution Type and Processing Type (post-
processing options are in development and coming soon).

Type Filters Screen

The  button enables/disables the name filter.  When 
it is on, four additional fields are shown to the right: one 

text field and three switches captioned ,  and 

.  Enter the search text in the text field and specify 
which switches are active (activated switches have a light 
blue background while deactivated switches are white):

      looks for names which begin from the search 
string;

      looks for names which contain the search string 
in the middle, but do not begin or end with it;

      looks for names which end with the search string.

Activating more than one switch combines the results: 

http://www.javad.com
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activate  and  searches for names which either 
begin with the search string or contain it in the middle.

To search for a range of numbers use the format of 
number1..number2. This format matches names which 
contain numbers in range between number1 and number2 
(in the position defined by switches).  E.g. if you enter 
3..9 (assuming all switches are on), it will match names 3, 
Stake04a, Pt9, but not names 14 or Point19a.

The  (Additional Actions) icon contains a list various 
options, settings and functions related to the Points screen.  
More information about the items contained in this menu 
can be found in each of the actions’ Help screen.  Of 
particular interest are Settings and Cluster Average.

Settings has options to allow the Point Name, Code and 
Description to all be displayed in the left panel of the Point 
screen rather than just displaying the Point Name.

Cluster Average finds groups of points in a cluster and 
creates an averaged point from the group.

Additional Actions screen

The information panel (the right blue panel) may contain 
more text than fits in its view.  If this is the case, tap and drag 
the panel to scroll its contents. 

Adjusting a Base Station Position

When a GNSS RTK base station is started by assuming an 
autonomous position, it is necessary and good practice to 
later adjust and correct the coordinates with a GNSS solution 
referenced from known coordinates.  J-Field, has the ability 
to adjust the RTK base station coordinates and RTK points 
surveyed using corrections from that base station.  There 
are three methods that can be used to accomplish this.

Manually Entering New Base Station Coordinates

Base station coordinates can be updated manually by 
entering new coordinates for the base station.  These new 
coordinates can obtained through post-processing the 
base station data with OPUS or Javad’s DPOS web interface.  
Follow these steps to apply the corrected coordinate to the 
base station and adjust all the points from this base station 
through J-Field:

1.  Select an RTK or base station point in the Points screen.

2.  Tap on the blue information panel displayed on the right 
side of this screen to view the Base Rover Statistics screen.

3.  Tap the Base button and you will be prompted to enter 
the corrected coordinates for the base station.

4.  Enter the new coordinates and tap OK.

Base Rover Statistics Screen

Prompt to Update the Coordinate of the Base Station 

J-Field will then search for all the points contained in the 
current project with the same original matching base 
station coordinates and apply offsets to adjust all these 
coordinates into the known coordinate system.  The 
adjusted coordinates along with the original base station 
and surveyed origin coordinates will still remain stored 
in the database for documentation purposes and so that 
adjustments can be undone or modified if necessary.  

http://www.javad.com
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CoGo Tool DPOS

When a Javad base station is started with J-Field using Base/
Rover Setup, the raw GNSS data is automatically saved in 
the base station receiver.  When the base station is then 
stopped with Base/Rover Setup, the data is downloaded 
into J-Field so that it will be available for post processing 
DPOS. 

To post-process the data, open the DPOS tool found in the 
CoGo menu and select the base file you wish to process.  
With the TRIUMPH-LS connected to the Internet, tap the 

button to upload the file to DPOS.  You will 
usually need to wait until the next day before submitting 
files to OPUS or DPOS as CORS (Continuously Operating 
Reference Stations) data isn’t available immediately.  After 
the DPOS solution has been received, thats files status will 
become “Waiting for adjusting permission”.  Review the 
solution by tapping the blue information panel to open 
the Base/Rover Statistics for the base station point.  An 
acceptable solution should have a Fixed solution, a 3dRMS 
of less that 3 cm (0.10’) and make use of multiple stations; if 
this is not the case, the data can be reprocessed again at a 
later time by pressing the DPOS button again.

If satisfied with the solution, click  to adjust the 
base station coordinate and all the survey points collected 
during the base station session.  After adjustment, the 
option to undo the adjustment will always exist.  Tap 

 if you ever desire to undo the adjustment.  The 
data can then be processed again with the DPOS button if 
desired.

CoGo DPOS - The Filter is Applied to Show Current Project 
Base Files Only

Base Rover Statistics Screen - An acceptable DPOS solution, 
Fixed, 3dRMS < 3cm and multiple stations (CORS)

The icons next to file displayed in the DPOS screen indicate 
the status of the file:

       - Downloading (from base receiver to J-Field)
       -  Uploading
       -  Awaiting DPOS results

       -  Waiting for adjusting permission
       - DPOS result applied

Real-Time Position Shift

Real-Time Position Shift, allows real-time corrections to be 
applied to receive base station corrections.  A base station 
can be started with an autonomous position and then 
corrected by surveying a point with known coordinates.  
The known point could be a point previously surveyed with 
a base station setup in a different location.  This feature is 
useful for several scenarios:

�� You need to move or “leapfrog” your base station to extend the radio 
range into a new area. 

�� Your original base station point has been lost. 

�� You wish to save time by starting the base station with it mounted to 
the top of your vehicle.  Setting the base station and radio up on the 
top of vehicle by mounting it a roof rack or using a magnet mount saves 
time by eliminating the need to setup tripods and can help protect the 
base station from disturbances or theft in undesirable locations.  For the 
best performance, the base station should be mounted in a near level 
position so that phase center variations and antenna offsets are correctly 
applied.  If you are parked on a sloped surface, a swivel mount  can be 
used to level the receiver on the top of your vehicle.  Your vehicle should 
be parked on solid ground where it will not move or sink.

The Real-time Position Shift function can be accessed 
from the Setup>General Group Edit>Advanced Real-
time Position Shift.  In this screen, select a point you have 
collected RTK coordinates from with an autonomous base 
station and then the known coordinates of this point.  
Check the Apply Shift and the shift will be applied to all the 
RTK surveyed points found in the current project collected 
from this base station.  This shift will continue to be applied 

to all the points surveyed from this base station.

Position Shift Screen

Real-time Position Shift can also be accessed from the Collect 
Action screen by clicking the button below the Start button 
and changing the collection mode to Shift.  In this mode 
select the Known Point and then press Start from the action 
screen to collect a point so that the offset can be calculated.  
After it has been calculated you can apply the shift.

Position Shift Screen from the Collect Action Screen

http://www.javad.com
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Coordinate 
Systems

The Coordinate Systems 
screen  allows you to quickly 
access and create new 
coordinate systems based on 

the predefined systems with just a tap on this icon.  

It is important to note that this screen does not set the 
current coordinate system for the Project.  To change a  
Project’s coordinate system choose Project>Edit Current 
Project>Project Coordinate System in the Stake and Collect 
Prepare screens.  Each page in the Project can then also 
have separate coordinate systems, set from the Page and 
Coordinate System boxes in these screens.

Coordinate System Screen

Adding a State Plane Coordinate System

To add a new coordinate system that is currently not listed 
in the Coordinate System screen when the All Project button 

www.javad.comwww.javad.com 1918 Coordinate Systems Coordinate Systems

is selected at the top of the screen, tap the  (Add) 
button to open the Coordinate System Catalog.

Coordinate System Catalog Screen

When selecting a Regional system for your project from the 
vast catalog, filter the choices to just those relative to your 
geographic location by checking the Near Me box.  Select 
your Region, Country and type of coordinate system:

Select the appropriate Height System, Geoid, Input Epoch 
and Transformation.  The typical coordinate system 
configurations for a US State Place Coordinate System is 
shown:

For latitudes south of 42N, “Geoid12B CONUS South 42N” 
should be chosen and for latitudes north of 40N, “Geoid12B 
CONUS North 40N” should be chosen.

Creating an Adjusted Grid-To-Ground 
Coordinate System

It is important to remember that GNSS distances measured 
in State Place Coordinate Systems may not match measured 
ground distances exactly and typically need to be scaled to 
ground 

With your state plane coordinate system selected in the 
Coordinate System screen click the Additional Actions 

button  and tap Duplicate to create a copy of this 
coordinate system.  The duplicated system will be created 
with the date appended to the end of its name:

http://www.javad.com
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Now highlight the duplicated system and tap the  edit 
icon  and choose Adjust Grid-to-Ground & Rename:

Adjust Grid-to-Ground & Rename Screen

Tap the Default button  to change the coordinate 
system name to the default name:

Tap the position icon  beside East Origin to set origin 
point in the grid system for the transformation.  Here the 
base station coordinate is chosen from the points List:

By default the ground origin point will be populated with 
the same coordinate and the Scale Difference is populated 
with the grid-to-ground scale factor calculated from that 
point.  The scale factor rounded to the nearest part-per-
million (ppm) is automatically appended to the coordinate 
system name:

You may also wish to round the scale difference to the 
nearest ppm by tapping its button and entering that value.  
In this screen options exist to enter a new factor as a Ratio 

or Ppm:

The Factors button will allow you to use the CoGo Scale 
Factor function to calculate a new scale factor if desired.

These settings will create an adjusted state plane coordinate 
system scaled around the base station and the base station 
coordinate will not change.  This is useful for projects that 
have ground distances as would be measured with a total 
station and state plane coordinate system bearings since 
the rotation is set to 0.  The coordinates will be very close 
to the real state plane system so that orthographic imagery 
and state plane referenced contours or elevation models 
can be loaded into your CAD drawings.  You should be 
cautious when giving these coordinates to others as they 
may confuse them for real state plane coordinates.  To 
solve this problem you may wish to subtract 100,000 from 
the North and East Ground coordinate values to create a 
(100,000 100,000) offset from the real state plane system.  
This can be done by tapping the North Ground and East 
Ground boxes.

Tap the  button to add the current project’s name to 

http://www.javad.com
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the beginning of the coordinate system name:

 
Press OK and then Apply to create this coordinate system:  

You can now use this coordinate system as the Project 
Coordinate System or just for some Pages if you choose.

Files and Data Exchange

Data transfers between the TRIUMPH-LS and your PC are 
facilitated through using either a USB cabled connection, 
a USB flash drive, a cloud drive or a network drive.  Using 
a cloud drive or USB flash drive are the simplest and 
recommended methods to transfer data between your PC 
and J-Field.

Data Base Structure and Customize 
Screen

Each J-Field Project has a “data.db” file stored in its project 
folder found in “Internal Memory\ VS Data\Maps”.  All the 
points and lines for a project are stored in this file.  By default, 
the Internal Memory is hidden.  To allow it to be visible in 
J-Field you can enable this option from System>Customize.

The Long Click Time setting in the Customize screen con-
trols how long a button must be held down to register as 
a Long Click.  Some button in J-Field preform two actions 
with the second action being initiated with a Long Click.  
Buttons with these second actions typically display a small 
down arrow in their bottom left corner.

Check the Double Vial Detector option if you are using the 
Javad rover rod with a double leveling vial.  This allows the 
downward facing camera to detect both vials.

Click on ‘Connect 
without setting up 
your device’

 Customize Screen 

Working with WMDC

Using the provided micro USB Cable will allow you to browse 
the contents of the TRIUMPH-LS using Windows Mobile 
Device Center (WMDC); take care not to delete system files! 

The first time that you connect the two devices, Windows 
will install Windows Mobile Device Center, a pretty 
straightforward process largely tailored to other types of 
mobile devices.
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Click on ‘File Management’, 
and then ‘Browse the 
contents of your device’

Good practice is to use 
the provided microSD 
card for survey-related 
data storage including 
Media, Photos, 
Screenshots and 
Spectrum data.

This is how the 
TRIUMPH-LS is seen by 
Windows

Windows operating 
system, J-Field, support 
files etc. are in the root 
directory.

When present, the 
attached USB dongle 
device will show here too

Survey projects 
are automatically 

assigned to their own 
folders at the time of the 
Project’s creation and are 
similarly named as the 
project.  All projects are in 
sub-folders beneath the 
parent folder ‘Maps’

Mounting a Cloud Drive

J-Field supports Google Drive and Dropbox cloud drives.

Files>Browse Files screen showing mounted Google Drive, 
Dropbox and a shared network folder.

To mount a cloud drive navigate to https://app.javad.com/
jca/#/inventory/devices and login from your PC’s browser.  
If you have not setup a Javad.com login, you will need to 
do so.

After signing in you will be prompted to Grant access.

Click Generate Key and a new alphanumeric key will 
appear. In J-Field open System>Dropbox/Google Drive and 
tap Handshake Key to enter this key.  Then click Establish 
Connection.  Note that J-Field needs to have an Internet 
connection established during this process.

Once this is completed, return to your web browser 
and select Cloud accounts in the left pane.  Then click 
Connect Google Drive or Connect Dropbox.  You will be 
prompted for your credentials for these accounts.

After these steps are completed open Files>Browse Files 

and click the context menu icon  and choose 
Mount Cloud Drive.  You should see your Google and 
Dropbox accounts listed if you completed the previous 
steps correctly.  Choose the desired account and press 
OK. 
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Mounting a Shared Network Folder

Mounting a shared network folder allows files to be 
transfered to and from J-Field while it is connected to a local 
network.  First a folder from a PC connected to the same 
local network as the TRIUMPH-LS needs to be created.

Here the folder TriumphLS was created on the Desktop.  
Right clicked on it, selected Properties and then enabled 
Sharing in the Sharing tab.

Then in the Browse Files screen, choose Mount Network 
Share from the File Operations menu when you are in the 
System Root directory.

Then enter the network path as shown above along with 
your Windows account name and password.

Press OK and you should now see this folder shared in the 
Root Directory where it can be used to import and export 
files.

Note that if an error message is received while trying to read 
the network shared folder, it may be necessary to reboot 
the TRIUMPH-LS to resolve this.  This is a known issue with 
the Windows operating system in the TRIUMPH-LS.

Importing Points From a Text File

To import points from a text file open the Data Exchange 
screen from the Home Screen 2 or from Files>Data Exchange.

Data Exchange Screen

Navigate to the location where your file is located using 

the   to go up a directory and Open to open a folder.    
Then select and highlight the text file to open and choose 
Open.  (Notice the down arrow in the corner of the Navigate 
Up button.  Holding this button down will initiate a Long 
Click and navigate to the system Root directory.)

Open File Screen - Filtered to show only text files

If your text file is configured with the standard format of 
“PointName, N, E, H, Description” you should configure the 
import settings as shown below if they are not presently 
configured this way.  The preview should display if the 
format is being interpreted correctly.
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If the preview is correct, press Next.

A summary screen will be displayed.  The points will be 
imported into the selected Page and be imported to 
the coordinate system of that Page.  Tap Import to finish 
importing the points.

Exporting Points To a Text File

To export points to a text file open the Data Exchange 
screen and choose the Export option.  Choose the format 
of the file type you wish to export with the box in the lower 
right corner, in this case Text/CSV.  Navigate to folder you 
wish to save the file.  Click Save File in This Folder or the 
New button to proceed.  If you desire to change the default 
filename of the file to be created, you may do so by clicking 
on the filename box displayed to the right of  Save File in 
This Folder.

Save File Screen - Set to save a txt file in the USB drive

The Export Formatting screen will be displayed.  It should 
have the default configuration to export a “PointName, N, E, 
H, Description” file with the description field being a merged 
field J-Field’s Code, Attributes and Description fields.  These 
fields are merged together with the use of Sep. 2 (Separator 
2) set to be a space.  By default, fields are separated with 
Sep. 1, typically set to be a comma.  Highlighting a field from 
the box on the left side of the screen and tapping Sep. 2 will 
add a plus sign after the field name to indicate that it will be 
separated with Sep. 2.

Export Formatting Screen with Default Formatting Shown

The plus and minus buttons are used to add and remove 
fields while the up and down arrows will change the 
order of fields.  Presets allows configurations to be saved 
and recalled.  Options are displayed to set the number of 
Decimals exported and whether to export a Header Line.  
More Settings opens the Export CSV Settings screen where 
options exist to specify how to format cut and fill values and 
Surveyed Design Points.

Export CSV Settings Screen

Use Export Range to choose which points to export.

What to Export Screen

After the settings and points to export have been selected, 
tap Next to preview the formatting and points before 
pressing Export to create the file.

Export File Preview Screen
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Exporting Photos, Screenshots, GNSS 
Data and Project Archives

To export media files that include photos, screenshots, 
audio files and raw GNSS data files choose the Project 
Archive File (ZIP) format option in the Save File screen.  A 
full Project Archive  can also be exported with this option.  A 
Project Archive  contains all the files necessary to restore the 
project if it becomes corrupt or deleted.  It can also be used 
to copy the project to a different TRIUMPH-LS.

Save File Screen - Set to save a Project Archive file in the USB 
drive

After tapping Save File in This Folder or the New button you 
will be presented with options to specify what type of files 
to export in the Export Project Archive screen.  Use the Full 
option to create a backup that can be restored.  The Only 
Media option will export only the filetypes chosen.  Press 
Create to export the files which will all be contained in a zip 
file.

Export Project Archive Screen - Set to export only photos 
(screenshots included) and raw GNSS files

Exporting A Project Report

A report of the Project can be exported in HTML or PDF 
format by choosing HTML or PDF format in the Save File 
screen.  The report will contain the selected points with 
all the details and statistics about that point.  The Text & 
Images will be included if this option is checked.  A number 
of options exist to format the PDF or HTML report:

ShapeTags & 
Codes

Create and manage your 
own library of Codes; alpha-
numeric textual assignments 

to points.  Codes can quickly be recalled from the Favorite 
Codes screen, eliminating the need to type in a point 
description for each surveyed point.  In addition, each Code 
can have up to five Code Attributes fields.  An example of 
a Code is “IPF” (Iron Pin Found).  It can then be setup with 
Code Attribute fields of “Size”, “Cap” and “Status” which allow 
these attributes to be entered and stored with each point.   
Choose Tags & Codes>Manage Codes to access the library of 
Codes.

Manage Codes Screen

Tap Create or Edit to make a new Code or edit an existing 
one.  A Symbol, ID, Category and Code Description can be 
assigned each Code.  If a Symbol is associated with a Code, 
points with that code will have the Symbol displayed on 
the map.  The ID field is a numerical field that is not used 
in J-Field but is an export option for text files and may be 

useful with other software packages.  The Category can be 
used as a filter in the Manage Codes screen.

Edit Code Screen

ShapeTags can be assigned to points during data collection 
to enable the automated drawing of lines between points 
with like ShapeTags.  For example, you may want to create a 
ShapeTag of “Fence”.  When collecting a point along a fence, 
select the “Fence” ShapeTag to be assigned with that point.  
This will cause a line to be drawn on the map between 
that point and the previous point that also has the “Fence” 
ShapeTag.

ShapeTags are associated with a chosen Code when a new 
ShapeTag is created.  When a ShapeTag is then selected to be 
assigned to a point, by default, the Code field for that point 
will be populated with the associated Code.
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Setup

J-Field’s settings are divided 
into 3 profile groups: the 
General Group, Action Group 
and Favorite ShapeTags and 
Codes.  These groups exist 
so that different settings 
groups can quickly and 
easily be saved and recalled.

The General Group profile stores the settings for RTK 
corrections, i.e. the configurations for UHF radios or 
connection parameters to a RTN.  The Advanced Settings are 
also stored in the General Group and are found as an option 
in the first setup screen of the General Group, they include 
the settings for the displayed units.  Tap Edit>Advanced to 
access them.  The configuration of the Stake and Collect 
Action screens’ User Defined (whitebox) Buttons are stored in 
the General Group profile as well.

As an example, to configure a new RTN setup you would tap 
Create to create a new General Group profile and then follow 
the screen prompts to enter the communication parameters 
and settings.  Copy As creates a copy of the existing profile 
but prompts you to enter a new name for the new profile.

The  (Set Up) will quickly open the Setup screen; 
pressing it twice opens the Advanced Settings Screen.

Setup Screen

Advanced Settings Screen

Tapping the Recall / Manage button will open a list of 
profiles shown on the left side of the Profiles screen.  Details 
of that profile are displayed in the information panel (the 
blue box on the right side of the screen).  Across the top 
from left to right are buttons to Rename, Delete, Search, 
Sort Alphabetically, Sort by Date.

General Group Profiles Screen

The Action Group profile contains the collection settings.  
These include the RTK Verification and Validation settings 
and how many epochs to collect.  These settings are 
discussed in the Collect section of this manual.

Action Setup Screen

The Favorite ShapeTags & Codes profile stores different list 
of favorite ShapesTags and Codes.

Setup Favorite ShapeTags & Codes Screen
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Setup Screen - Creating a new General Group profile

Enter a profile name (“UHF” or “FH915 SS” are suggested) in 
the next screen and tap OK.  The next screen will prompt 
you to select the Operating Mode, choose RTK Rover:

You could tap Next and continue to configure all the 
communion parameters but this is not necessary as they 
can also be configured with Base/Rover Setup.  Press Back 
and then Esc to return to the Home screen.

Base/Rover Setup

Base/Rover Setup is used to configure and start the 
transmission of RTK corrections via UHF or FH915 SS 
(frequency hopping spread spectrum) radios from your 
Javad Base receiver and radio to your Rover.  It reads the 
communication parameters from a UHF or SS General Group 
rover profile and creates a matching base station profile 
internally.  It then sends that base station profile to the base 
through the Bluetooth connection.

Before Base/Rover Setup can be used a UHF or FH915 SS 
General Group rover profile is needed.  If one does not exist 
yet, open the Setup screen and tap Create for a new General 
Group profile:

Once a UHF or FH915 SS General Group profile has been 
created and recalled, tap the Base/Rover Setup button from 
the second page of the Home screen.

If for some reason the selected profile is not in UHF or FH915 
SS mode a message will be displayed indicating so.

Should that be the case, tap Recall to select a UHF or FH915 
SS radio profile or tap the displayed message to change the 
current General Group profile into a UHF or FH915 SS profile.

To connect the Base and the Rover via Bluetooth, tap 
on Connect.  The external radio, if using one, should be 
powered on prior to pressing Connect.  Always have an 
antenna connected to the radio before powering it on to 
avoid potential damage to the radio.
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Immediately a scan of available Bluetooth devices will 
begin and a few seconds later will be completed. Choose 
the device intended to be used as the Base receiver and tap 
Connect.

Once the Bluetooth connection has been initiated, it will 
take a few seconds before it has completed. During that 
interim few seconds, your screen may appear like what is 
shown on the right.

Once the existing Base and radio parameters have been 
retrieved the screen should look similar to this.  The Rover 
profile radio parameters are displayed on the left panel while 
the current Base coordinate is displayed on the right.  Radio 
parameters displayed in red indicate that there is a different 
value between the Base and Rover profile.  Use From Base to 
update the Rover profile to the parameters from the Base or 
use To Base to send the Rover radio parameters to the Base 
before starting the Base.

Tapping the left panel opens the screen to configure the 
radio parameters.  “RTCM 3.0 Min” Format should be used to 
minimize the correction data that must be sent through the 
radio.  To start the base with 5 Hz BEAST MODE corrections 
the Broadcast Period must be changed to 0.2 seconds. 

The time required to acquire a fix is inversely proportional 
to the rate of the corrections.  By reducing the time for the 
RTK engines to fix, RTK Verification and Validation can be 
completed much quicker and surveyors can collect points 
in locations that previously proved to be very difficult and 
time consuming.

It is important to note that increasing the Broadcast Period, 
increases the battery consumption of the radio as well as 
the heat generation inside it.  If you are using HPT401BT, 
HPT901BT or TRIUMPH-1 Internal Radio you will need to 
connect an external battery if you intend to operate the 
Base at 5 Hz for more than a few hours.  With HPT435BT you 
may need to use the modem fan when broadcasting with 
an output power greater than 4 watts, depending upon the 
ambient temperature. 

The Base ID field limits the Rover from receiving corrections 
if the Base and Rover profiles do not have the same Base ID.  
It can be left at its default value of 0.

Transmit L2C is always enabled.  If for some reason it is not 
checked, it will become enabled automatically when the 
Base is started with Base/Rover Setup.

To configure the UHF or FH915 parameters tap the UHF or 
FH915 Configuration button. 

UHF Base Configuration Screen

FH915 SS Base Configuration Screen
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Tapping the UHF or FH915 Configuration button will trigger 
an immediate search for the radio via Bluetooth between the 
Base and the radio. If a Bluetooth enabled radio is not found 
to be currently paired to the Base, you will be prompted to 
pair the radio.  This can be done via the Bluetooth option.

For UHF radios the parameters shown to the right need 
to be configured.  The Frequency  should be one of your 
FCC licensed (US users) frequencies.  A channel with 
little interference should be chosen.  From the Frequency 
selection screen you can Scan the displayed channels to 
check the interference levels.

A Modulation (the method the data is encoded in the 
radio signal) must be selected that has a sufficient link rate 
to transmit increased data rates with 5 Hz corrections.  If 
Channel Bandwidth is limited to 12.5 kHz by a FCC license, 
D16QAM modulation must be used.  With 2 Hz corrections 
(0.5 second broadcast period) D8PSK modulation can 
also be used.  Modulations with greater link rates have 
decreased receiver sensitivity to demodulate the signal 
and the downside to choosing modulations with higher 
link rates is that they are more subject to interference and 
data loss when the signal is weak.  Field test have found 
that D16QAM modulation decreases the working range 
of the radio approximately 20% as compared to DQPSK 
modulation.

Increasing the Output Power increases radio range but 
also increases radio power consumption.  With an antenna 
height 4 m (13.1 ft) and D16QAM modulation, 5 Hz RTK can 

UHF Configuration Screen

be stable up to 4 km (2.5 miles) away when terrain obstacles 
do not block the signal.  A hill or ridge between the Base and 
Rover will greatly limit the range.  The FCC (US) allows up to 
35 watts ERP (Effective Radiated Power) to be transmitted.  
If you have a HPT435BT radio set to output 35 watts and are 
using an antenna that isn’t a unity gain antenna, such as the 
5 dBd gain whip antenna, you aren’t in conformance with 
the FCC regulations and terms of your license.  With the 5 
dBd gain whip antenna, an Output Power of 10 watts or less 
must be used to stay under 35 watts ERP.

Your FCC assigned call sign should be entered in the Call 
Sign box.

The Unpair button is used to unpair the Bluetooth 
connection between the base and Rover.  This would only 
be necessary if you wish to pair a different radio to your 
Base.

Update FW checks and installs the latest radio firmware.  
The versions released October of 2015 or later are needed 
for 5 Hz corrections to work correctly.

FH915 SS Radio Settings

With a FH915 SS radio Packet Repeating must be disabled 
when using correction rates greater than 1 Hz.

In the US it may be best to operate on Channel 7 to avoid 
interference.

Field test confirm 4 km (2.5 miles) as the range at which 
stable 5 Hz RTK can be achieved with a FH915 SS radio with a 
4 m (13.1 ft) antenna height.  With 2 m you may achieve up to 
2 km (1.2 miles), but it is dependent upon the environment. FH915 SS Configuration Screen
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Return to main Base/Rover Setup screen by tapping OK 
twice.  Press To Base to send modified parameters to the 
Base.  After doing this all the parameter values should be 
yellow.

The Base broadcast coordinate should now be set.  Tap on 
the coordinate pane on the right side of the screen.

If the base is being started on a known point select that point 
From List or Enter the coordinates manually; otherwise use 
an autonomous position by tapping From Auto.

The 2D Delta indicates the horizontal distance between the 
current autonomous position the base is reporting and the 
proposed broadcast coordinate.

Enter the Antenna Height and Offset.  In this case the Base 
is  on a 2 m pole with the thread adapter that adds an 
additional 0.025 m.  Tap OK once done.

The base station raw GNSS data is always recorded and then 
transfered to J-Field when Stop Base is pressed at the end 
of a survey session so that it can be sent to Javad’s Data 
Processing Online Service, also known as DPOS.  With the 
DPOS tool found in the CoGo menu the raw data file can be 
submitted to DPOS and all the survey points from that base 
station session can be adjusted to their real coordinates so 
they are no longer based off an autonomous position.  The 
recording interval can be specified along with some DPOS 
options with the Rec box. 

Once the coordinates for the Base have been selected/
entered along with Antenna Height and radio parameters 
tap Start Base.

In this screen you can enter / change the name of the point 
being used as the base; to do so, tap Stored Point Name 
and enter the desired name.  It is recommended the Project 
Name being included in the point name so that the file can 
easily be identified in the DPOS tool.

Confirm sending the coordinates to the Base with a tap on 
Yes, Store Point and Send to Base.  

The parameters will be sent to the Base and radio and the 
Base should begin to broadcast, typically after about 80 
seconds.

The  (transmit) icon will indicate when the Base is 
transmitting and OK will be displayed to the right of it.  

Similarly, the  (receive) will indicate when the Rover is 
receiving data.  If the icon bars are red (as shown with one 
red bar), this indicates that the radio transmission is over 
powering the receiving radio and that the Rover is too close 
for set Output Power.  If the broadcast is too overpowering, 
corrections will be lost and the link quality will drop.
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Once the Base is broadcasting you can check that the Rover 
is correctly receiving corrections at the set transmission 
rate.  Open the Collect or Stake Action screen.  The position 
solution button should display the correct incoming 
correction rate and the communication button should 
display a 100% link quality.

To check that you have started the Base correctly with the 
correct coordinate, you may wish to stake a point you have 
previously located if you have one available.

After the Base has been started you can press Done to 
disconnect the bluetooth or alternatively the connection will 
be disconnected when the distance between the Base and 
Rover exceeds the range of the Bluetooth communication.

After finishing surveying return to the Base again and 
open Base/Rover Setup to Connect again and stop the 
base with Stop Base.  This will display a prompt to stop 
the data transmissions and download the Base GNSS data 
into J-Field.  Choose Stop & Download.  After the download 
completes the Base can be powered off, the radio can be 
powered off while the data is downloading without causing 
any problems.CFG if this is the case.

Troubleshooting Starting the Base

If for some reason problems are encountered when trying 
to start the Base, clearing the Base NVRAM is usually the first 
recommendation. 

How to clear the NVRAM

1.  Turn the receiver OFF with the ON/OFF button.
2.  Press and hold the Record button.
3.  Turn the receiver ON by pressing the ON/OFF button.
4.  Wait until all the LEDs are flashing yellow (except the 
battery LED).
5.  Release the Record button.

If the radio is transmitting, its TX LED should be flashing 
at the broadcast rate.  If the radio is broadcasting but 
corrections are not being received in J-Field, check the UHF 
Status screen for an “err” listed in the UHF State.  If an error 
state is displayed, press Restore CFG to restore the factory 
UHF configuration.

UHF Status Screen - UHF State “err, freq”, Use Restore CFG to 
repair
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which opens a screen to configure the collection settings 
for points.  The RTK Verification and Validation settings are 
configured from Action Setup screen.

Collect Prepare Screen

Pressing the Action hardware button or Next 
from the Collect Prepare screen opens the 
Collect Action screen. 

Collect

Pressing the Collect button 
opens the Collect Prepare 
screen; pressing Collect 
hardware button twice 
will open the Collect Action 
screen.

In the Collect Prepare screen, the Project, Page, Coordinate 
System, ShapeTag, Code, Code Attributes, Point Name, Point 
Description, Antenna Height and collection settings can be 
setup before beginning data collection for a point.

When collecting points, it is recommended to use the 
Code and Code Attributes to store information about the 
point being collected.  The Description field can then be 
reserved for entering additional information about the 
point.  When exporting point coordinates in Text/CSV 
format, these three fields can be merged into one field so 
that surveying software can import data with the traditional 
“Name,N,E,H,Description” format but with the description 
being the combination of J-Field’s Code, Code Attributes and 
Point Descriptions fields.

The Review buttons opens the Review screen which is a map 
of the project.  Here linework can be drawn on the map with 
the CAD functions and point data can be edited.

The View button opens a screen to configure what point 
attributes are displayed on the map and allows some 
graphical parameters to be customized.

To the right of the View button is the Action Setup button 

Screen Anatomy - Collect Prepare Screen

The Review buttons opens the Review 
screen which is a map of the project.  
Here linework can be drawn on the map 
with the CAD functions and point data 
can be edited. The View button opens a 

screen to configure what point 
attributes are displayed on the 
map and allows some graphical 
parameters to be customized.

The Project button displays the name 
of the current Project.  Tap it to open 
an existing Project, to create a new 
Project, or to edit the current Project’s 
name or coordinate system. 

The Page button displays the name 
of the current Page.  Tap it  to open 
the Pages screen and set the current 
Page, turn on or off Pages or edit a 
Page Name or coordinate system.  

The Coordinate System button displays 
the name of the coordinate system 
for the current Page.  Tap it to change 
this coordinate system.  

The Code button displays the name 
of the Code that will be assigned to 
the next surveyed point.  Tap it to 
choose a new Code from your list of 
Favorite Codes.  

Up to five variable Code Attributes 
fields can be used be used to store 
additional information about a point 
with this box.

ShapeTags can be assigned to points 
during data collection to enable the 
automated drawing of lines between 
points with like ShapeTags.   “DefTag” 
is the default ShapeTag and does not 
create lines between points. 

Edit the height of the ARP (Antenna 
Reference Point).

Takes you to the Action screen

The Point Name button displays the 
name that will be assigned to the 
next surveyed point.  After a point is 
surveyed it will increment to the next 
available name.

Displays the estimated remaining 
battery life and is a shortcut to 
the Battery Status screen

Displays the current Action Group 
profile name group and opens the 
Action Setup screen.  The rover icon 
displays whether tilt corrections are 
enabled or not (disabled above).  
The clock icon indicates the How to 
Stop? setting has been set to a fixed 
number of epochs.

Use the Point Description field to store 
additional information about the point.
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Action Profile Setup

The Action Setup screen can be opened by tapping the 
bottom middle button on the Collect and Stake Prepare 
screens.  It contains all the settings related to the collection 
of points.

Action Setup Screen - Recommended Settings for Multipath 
Environments

There several different options to specify when 
data collection for points starts and ends, the most 
commonly used options being with the Start Button 
and after a specified number of epochs have been 
collected.  Using a Start Delay may be useful if you 
need to collect a point where you cannot reach the 
TRIUMPH-LS.  You can press Start and then set the 
TRIUMPH-LS up over the desired point.  The starting 
of data collection will be delayed by the selected 
Delay period.

How to Start Screen

How to Stop Screen - Recommended Settings for Surveying 
Monuments in Multipath Environments with 5 Hz BEAST 
MODE Corrections

What To Record presents options to automatically capture 
raw GNSS data, camera images, voice recordings and 
screenshots.

Use Recall to quickly recall a saved Action Group profile.  This 
is useful for changing the collection settings for different 

environments and types of points that need to be collected.

If Activate Post-Processing is enabled, raw GNSS data 
will always to be logged in the background when 
points are collected.  If an RTK solution has not been 
accepted or rejected after the set period of time, 
options will be presented during point collection to 
save the GNSS data with the point for post-processing.

Activated Post-Processing Prompt after a fixed solution 
was not able to be collected.
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RTK Verification and Validation

It is very important that you read and understand the 
information about RTK Verification and Validation 
contained in this manual.  

Verify Settings Screen - Recommended Settings for Multipath 
Environments

When located in difficult environments and under tree 
canopy, all GNSS receivers are prone to give bad fixed 
solutions that may appear to be acceptable if they are not 
verified.  Existing methods to verify GNSS solutions include 
“dumping” the receiver, turning it upside down to cause the 
RTK engines to reset, and re-observing the point at a later 
time.

J-Field automates these processes with its built-in software 
features of Verify and Validate.  Verify automatically resets 
the RTK engines after every fixed epoch is collected in 
Phase-1 of its process.  Epochs are placed into Groups or 
buckets during Phase-1.  Once a Group has the required 
Confidence Level Phase-1 is complete.  

The Confidence Guard (CG) determines the size of the Group 
or bucket.  Each Group contains all the epochs located 
within a specified radius (the CG value) from its center and 
new Groups are created as necessary so that all epochs 
fall into at least one Group.  Each Group has its own Epoch 
Counter, Confidence Level and Elapsed Time. A point may fall 
into more than one group.  The current best group is shown 
within [ ] and others within ( ).

The number of groups is limited by the Max Groups setting. 
If this number of groups is exceeded, Phase-1 will reset and 
start over.  During Phase-1, the current best group will be 
displayed between the square brackets [ ] while the other 
groups are displayed between parenthesis ( ).

During Phase-2 the engines are not reset and solutions 
which are located inside the CG of the selected Group are 
added to that Group for the remaining number of epochs 
that user has requested (Epoch Number, EN) in the How 
to Stop screen.  Solutions which are outside the CG of the 
selected Group will be ignored; the RTK engines are reset if 
the epoch falls outside a sphere with a radius twice that of 
the CG.  If the number of rejected epochs reaches 30% of 
epochs collected so far, the whole process will restart.

Validation is the final step of the process.  With this feature 
enabled the RTK engines will reset one final time at the 
end of the observation and collect 10 additional epochs.  
Allowing sufficient time between Phase-1 and the final 
Validation step will guarantee a bad solution is not allowed 
to be accepted.  From extensive testing in the worst of 
multipath environments, a bad solution has yet to be 
accepted when Verify and Validate are enabled with Phase-2 
collecting epochs for at least120 seconds.  To accomplish 
this, set stop After (EN) to 120 epochs with 1 Hz corrections, 
240 epochs with 2 Hz corrections or 600 epochs with 5 Hz 
corrections.

Confidence Level and Consistency Level are counters; the 
Confidence Level of a group increments each time an epoch 
with a new RTK initiation (Fix) is collected.  It increments by 
values of 1, 1.25, 1.5, 1.75, 2.0, or 2.5 for 1 to 6 fixed engines, 
respectively.  The Consistency Level of a group increments 
with every epoch collected by values of 0, 0.1, 0.25, 0.5, 1.0, 
and 1.5 for 1 to 6 fixed engines.  The set Consistency Level 
must be met before Phase-2 is allowed to end.

If high accuracy is needed in areas of high multipath and 
areas with limited views of open sky (under full tree canopy 
and urban canyon environments), longer observations 
will improve accuracy.  Repeated observation can also 
be performed later (1 hour or more is recommended) to 
improve accuracy.  These repeated points can then be 
averaged together with the Average function found in Cogo 
Tools or with the Cluster Averaging function.

Recommended Collection Settings

Control, Boundary and Multipath Environments
�� Start with Start Button
�� Stop After: 120(1 Hz), 240(2 Hz) 600(5 Hz) epochs, 

may be reduced to 30 in open sky
�� Verify with V6 Reset
�� Confidence Level: 5 to 10 (10 will cause Phase-1 

to take long but results in less incorrect Phase-1 
positions)

�� Consistency Counter: 10
�� Min RTK Engines: At least 2
�� Validate Result: with at least 2 engines
�� Correct for Tilts: Off (Rover pole must be plumbed)

Precise Topographic
�� Start with Start Button or Start When Tilted

�� Stop After: 10 epochs
�� Verify with V6 Reset
�� Confidence Level: 5
�� Consistency Counter: 10
�� Min RTK Engines: At least 2
�� Validate Result: with at least 2 engines
�� Correct for Tilts: On*

Quick Topo for use with Open Sky Environments
�� Start with Start Button or Start When Tilted
�� Stop After: 2 epochs
�� Verify without V6 Reset
�� Consistency Counter: 0
�� Min RTK Engines: At least 4
�� Correct for Tilts: On*

In all cases
�� Accept Fixed Only, RMS: All, PDOP: All
�� Confidence Guard: 0.164 ft

If you wish to review point statistics or if you wish to edit the 
ShapeTag, Code, Description and/or Attributes fields after 
data collection, Auto Accept must be set to Off.  If these 
fields do not need to be changed and you desire fast data 
collection with the Quick Topo settings, set Auto Accept to 
On.

*If Correct for Tilts is on, the Level Offsets must be calibrated 
frequently if accuracies greater than 0.10’ are needed.
If the point you are attempting to locate is near the edge 
of a building, tree trunk or other obstruction, it often best 
to use one of the CoGo Offset functions. When the most 
accurate measurements are needed, the CoGo Resection 
function found in the Intersections group is recommended.
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Screen Anatomy - Collect Action Screen

The map displaying point and lines 
contained in pages that are enabled.  
To expand the User Defined Buttons 
press the Action hardware button.

Maximizes map view to full screen

Unassigned User Defined 
Button, tap to assign

Tap once to preform the action 
associated with the User Defined 
Button (AKA Whitebox); long click 
(touch and hold) to remove or 
change the User Defined Button from 

Shortcut to the applicable RTK corrections 
communications screen; Currently corrections are 
being received through WiFi with a 100% link 
quality and full signal strength  (as displayed by 
the full bars of the signal strength icon)

Begin collecting a point; the current 
time is displayed on the 2nd line

Shortcut to Selection of the type of 
feature being located; Point, Line 
Curve, Trajectory or Shift; choose by 
Survey or by Offset

Returns to the previous screen

Center map on current location

Zoom in, the scale is displayed as the 
distance across the bottom of the 
screen (between the user defined 
boxes).

Shortcut to Satellite Status screen; 
SV total*

Number of engines fixed/number of 
engines required by user

Shortcut to the Action Setup screen; 
the pitch (forward/back), roll (left/
right), and the azimuth or bearing 
the unit is facing are displayed.  This 
box turns orange if the device is 
tilted more that 5 ° with Correct for 
Tilts off, or more than 30 ° degrees 
with Correct for Tilts enabled.  When 
orange it prevents accepting of 
epochs in all modes except trajectory.

Zoom out

Current location in current Page 

Cycle through AutoZoom and 1:1 
Zoom modes

* Total number of SVs obsered by RTK 
Rover may be different from number 
of SVs observed by RTK Base

Instantaneous RMS estimate of the 
current position solution 

The current RTK correction rate being received

“FIX” (Fixed), “FLT” (Float), ”CDF” (WAAS Code 
Differential Float) or “STN” (Standalone) solution 
types are indicated.  Tap this box to open the RTK V6+ 
screen..

Shortcut to the Review screen

GNSS satellite 
count used in 
given engine

GPS GLONASS
3D RMS for the 
current epoch in 
given engine

Number of seconds 
since the last reset 
for a given engine

Distance from the 
solution of the 1st 
engine

Manually reset engines 
to compel new fixed 
solutions when automatic 
verification is turned off 
(unchecked) 

A user definable threshold showing 
allowable delay in seconds when 
Extrapolation Mode is used .

Charts plotting each fixed 
epoch for each engine

Screen Anatomy - RTK V6

Number of fixed 
solutions since all 
engines were reset 

Use this value 
to evaluate and 
compare the 
performance of each 
engine. 

Reset GNSS Tracking

Antenna Height

D-SNR loss, displays the level (in dB) of 
the signal strength loss and interfer-
ence in the L1 / L2 GPS and GLONASS 
bands.  Values  0-3 are desirable, 3-6 
are fair and above 6 are poor.
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Verify Statistics
# of Phase-1 Restarts, # of Groups

# of Epochs outside the Confidence Guard 
during Phase-2 

Coordinates of
current position

Current 
epoch count

Time: Duration is seconds between the 
first and last epoch collected

Current 
confidence 
level

Horizontal (left) and 
vertical (right) plots of the 
collected epochs.  Each 
Group has its own color.  
These plots currently have 
2 Groups.

Screen Anatomy - Collect Action Screen
Screenshot after Phase-1 of RTK Verification is Completed

* At the end of Verify sets 
values shown are the total 
RMS of all sets

Target 
confidence 
level

Current 
best 
group
in [ ]

Current 
other 
groups
in ( )

Example One: Phase-1 ONE

Scales of the plots

Horizontal Vertical

This Point was collected in a high multipath environment, several feet 
away from a 2 story building.

Final averaged 
position of all 
positions 

Number of 
epochs used in 
final position

Consistency Level 
of the Point

Confidence Level 
of the Point

Screen Anatomy - Map Screen
Screenshot after Phase-2 and Validation Phase of RTK Verification is Completed

HRMS and VRMS 
of the Point in 
units of 0.01 ft

Time between 
first and last 
epoch in seconds

Example One: Phase-2

Peak to peak distance
Horizontal Vertical

Current page’s linear units

Verify Statistics
# of Phase-1 Restarts, # of Groups

# of Epochs outside the Confidence Guard 
during Phase-2 

This Point was collected in a high multipath environment, several feet 
away from a 2 story building.  The effect of multipath can be seen with 
the large vertical spread displayed in the vertical plot.

Vertical Drift in mm per 
minute  (RMS of the 
Vertical Drift)
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Screen Anatomy - Collect Action 
Screen with Expanded User 
Defined Buttons

The User Defined Buttons are expanded by pressing the 
Action hardware button.  The most commonly used and 
recommend User Defined Button options are shown 
below:

Many of the selected options are inputs for the same 
parameters in the Collect Prepare screen.  As with every 
screen, more details can be found by pressing the Help 
hardware button.

Stake

Similar to the Collect Prepare 
screen in appearance 
and function, the Stake 
Prepare screen allows you 
to configure the settings for 
staking points.

Stake Prepare Screen

Additionally, the Prepare to Stake screen allows you to 
define various Modes to stake which include a Points Mode, 
several Alignment Points Mode and Alignment Stake-Here 
Mode.

Sequence defines the order of the points to be stake.  The 
From Map mode is suggested mode for new users.  This 
allows you to pan the map cursor over a point displayed in 
the map and tap Next to select that point to be staked.

Stake Sequence Screen

The suggested User Defined Button options for new users 
are displayed in the follow two screenshots.

Stake Action Screen

When near the target point being staked tap Start to begin 
collecting data and to average the displayed offset values.  
When staking a point in a multipath environment, this is 
an essential step that must be used with RTK Verification to 
ensure the RTK initiation is correct.  Choose Accept to store 

the staked coordinate or Reject to discard them or to adjust 
the position and try again.

Stake Action Expanded Screen

The CTT (Course to Target) Arrow User Defined Button option 
in the top left box displays the direction to the point 
being staked while the distance to it is displayed in the 
DTT (Distance to Target) whitebox below it.  Further down 
are the Ahead/Back and Right/Left boxes that display the 
distances to the point relative to the TRIUMPH-LS.   The Cut/
Fill option is in the lower right box.

On the right side, the Target Name option is used as another 
method to select the point being staked.  When it is added 
as a whitebox you must choose whether to “Key-in target 
point name” or “Select target point from list”.  Select the 
option you prefer.  Below it are Point Description, Accept As 
and Verify Statistics whitebox options.

The Accept As whitebox is useful if you wish to store the 
staked coordinate of a design point as new point rather 
than having it stored in the design point’s record.  After 
collecting the staked design point press Accept As rather 
than Accept if you desire to store it as a new point.
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